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Audio interface and control surface

Functions of the audio interface and control surface

This section explains how to set up and use the functions of the R16 audio interface and 
control surface with DAW software installed on your computer.

 Control surface functions
The on-board control surface functions can 
be used to control DAW software on your 
computer via USB. Transport operations, 
including playback, recording and stopping, 
and physical control of the DAW faders 
are possible. Furthermore, various other 
DAW software functions can be mapped 
to the F1~F5 keys. (The available functions 
depend on the DAW software used.)

DAW software

Cubase LE 4, etc.

Windows/Mac

USB Cable

R16

 [PHONES] jack
Playback device like 
headphones or an 
audio system

[OUTPUT] jacks
Stereo system,
speakers with built-in 
amplifiers, etc.

[INPUT 1-8] jacks
Guitars and other 
musical instruments,
internal stereo mic

Audio driver

プラグのイメージ

 Audio interface
The various input and output jacks of the 
R16 can be used as a Hi-Speed USB (USB 
2.0) audio interface with support for 8 ins 
and 2 outs and input and output quality up 
to 24-bit/96kHz. Effects can also be used 
when the sampling rate is 44.1 kHz, and 
the unit can be powered by the computer’s 
USB bus. 
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 Multifunction tuner
In addition to standard chromatic tuning, 
the multifunction tuner also has on-board 
support for 7-string guitar, 5-string bass 
and various drop tunings.

 Comprehensive built-in mixer
Using the R16’s mixer, you can make a 
mix for monitoring live and playback. When 
simultaneously recording guitar and vocals, 
for example, you can independently adjust 
volume balance, panning and reverb levels.

 Versatile effect functions
The insert effect can be applied to specific 
channel paths and the send/return effect 
works via the mixer send/return. The two 
kinds of built-in effects can be applied when 
recording, of course, but they can also be 
applied to affect only the monitoring output. 
For example, when recording vocals, you 
can apply reverb to the monitor signal to 
make singing easier, but record a dry signal.

 Supports input from a variety 
of sources, including guitars, 
mics and line level instruments.
The 8 onboard jacks, which accept XLR 
and standard phone plugs, include one 
high-impedance input and two with 48V 
phantom power. From high-impedance 
gu i tars and basses to dynamic and 
condenser microphones and line-level 
devices like synthesizers, many sources are 
supported.  In addition, the built-in high-
performance condenser microphones are 
convenient for recording acoustic guitar and 
vocals.
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➊ ➋

Cubase LE 4 installation overview

By using the R16 between a computer and external 

devices and instruments, their signals can be 

recorded using programs such as DAW software.  

Instrument types that require Hi-Z or phantom 

power can also be connected.

Using the fader or keys on the R16, you can control 

transport operation and mixing in digital audio 

workstation (DAW) software on your computer.

To use the R16 with a DAW, you need to install an R16 driver and set the DAW so that it can recognize 
the R16. Here, we explain how to do this with Cubase LE 4.

	 Install DAW software	 … P.5

	 Install driver	

ZOOM R16 audio driver

	 Audio interface setup	

	 Connect R16 to computer	 … P.7

	 Device setup	

	 Control surface setup	

ZOOM R16 audio driver

Mackie Control

	 DAW software setup	 … P.9, 29

Cubase LE 4

➊ Audio interface ➋ Control surface

	 Recording	  … P.15
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R16 audio interface system environment
To use DAW software with this unit, you need to install it and make settings in it for the R16. This is 
an explanation for doing so with Cubase LE4.

Please refer to the USB/Cubase LE 4 Startup Guide 
for detailed instructions for installing the R16 audio 
driver and Cubase LE 4.

R16 audio interface system 

requirements

Cubase LE 4 installation guide

“PDF Manuals and Drivers” CD-ROM supplied with R16
Drivers>Windows “Setup.exe”
or
Download the latest “ZOOM R16 Audio Driver” from 
ZOOM homepage (http://zoom.co.jp)
and install it on a computer.

[How to install the driver]

   Set language selection 

Continued overleaf

Cubase LE 4 Startup Guide

This Cubase LE 4 Startup Guide explains how to install Cubase LE 4 on a computer, make connections and other settings for the R16.Windows Vista / XP

To connect the R16 to a computer running Windows Vista 
(or Windows XP) and to enable audio input/output, proceed 
as follows. The installation description uses Windows Vista 
as an example.

Insert the supplied “Cubase LE 4” DVD-ROM into 
the DVD drive of the computer.

Bring up the “Sound” window from the Control Panel 
and make the input device setting for the computer.

   Start “Found New hardware Wizard”

   “Found New Hardware Wizard completed”

  HINT

  NOTE

  NOTE
  NOTE

Set and connect the R16 to the computer 
using a USB cable.

Connect USB cable to the R16

Connect USB cable 
to computer

Select 

Press.

Execute.

Press.

Select of how to continue settings.

Press.

1
2

3

4

5

6

Press.

How to set and connect the R16

   Start InstallShield Wizard 

   Driver-Plug In selection screen 

   Ready to install the program 

   InstallShield Wizard was completed 

DAW software

R16

Windows
Windows® XP SP2 or later/Windows® Vista SP1 or 
later
1.8GHz Intel® Pentium® 4 or faster
1GB RAM minimum

Intel Mac
OS X 10.4.11 or later/10.5 or later
1.83GHz Intel® CoreTM Duo processor or faster
1GB RAM minimum

Both
USB 2.0 compatible port

* 64-bit operating systems are not supported.
* USB hubs are not supported.

About the screen images
The screen images are of the Windows version. 

About trademarks

 · The SD symbol  and  SDHC symbol are trademarks. 

· Windows®/Windows Vista® are trademarks or registered trademarks of Microsoft®. 

 · Macintosh®, Mac OS® and Logic are trademarks or registered trademarks of Apple Inc. 

 · Steinberg and Cubase are trademarks or registered trademarks of Steinberg Media Technologies GmbH Inc. 

 · Intel® and Pentium® are trademarks or registered trademarks of Intel Corporation.

 · AMD Athlon® is a trademark or registered trademark of Advanced Micro Devices, Inc. 

 · MACKIE Control is a trademark or registered trademark of LOUD Technologies. 
 · SONAR is a trademark or registered trademark of Cakewalk, Inc. 
 · Ableton Live is a trademark or registered trademark of Ableton AG. 
 · Digital Performer is a trademark or registered trademark of Mark of the Unicorn. 
 · All other trademarks, product names, and company names mentioned in this documentation are the property 
   of their respective owners.
 · All trademarks and registered trademarks mentioned in this manual are for identification purposes only and are 
   not intended to infringe on the copyrighted properties of their respective owners.
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Connecting and disconnecting in audio interface mode

Reference: “USB/Cubase LE 4 Install Guide”

Install/setup details

This is a brief overview of connecting and disconnecting when a computer is hooked to the 
R16 by USB cable. For details, please refer to the separately attached “Installation Guide.”

Connecting the R16 to the computer 
for the first time

Connect the R16 to the computer.

R16 setup and connection

Setup DAW software

	 Device setup                        P.00

Control surface setup (Mackie Control) P.00

Install Cubase LE 4 DAW 
software on the computer1 1 Press [USB].

USB	
>AUDIO INTERFACE

Change 
menu

Press [Enter].

Select >AUDIO INTERFACE.
Download the latest ZOOM R16 
audio driver from the ZOOM 
website (see below).

2 2

SETTING?
[CONTINUE] RESET

Change 
menu

Press [Enter].

Select “Continue.”4

AUDIO INTERFACE
Enter?

Press [Enter].

 Verify.

Install the audio driver on the 
computer.3

5

4

3

R16 setup and connection
Follow these procedures from the second time connecting

  NOTE

The ZOOM R16 audio driver is essential for using 

the R16 as an audio interface for DAW software 

such as Cubase LE 4.

When downloading, follow the included instruction 

guide to install correctly.

 Please download the latest R16 audio

    driver from Zoom Corporation’s website 

    at (http://www.zoom.co.jp).

  NOTE
•	 Set the recording quantization (bit depth) of 

Cubase LE 4 or the DAW software that you are 

using to 24-bit in order to achieve the best audio 

quality when recording. (See the software manual 

for how to make this setting.)
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 · The audio interface and control surface functions 

of the R16 can be used by drawing power 

through the USB bus. Power from batteries or 

the adapter is not necessary.

 · We recommend always using the latest R16 

system software. Operating the R16 with an older 

system could result in it not being recognized by 

your computer.

1 Press [USB].

AUDIO INTERFACE
Terminate?

Press [Enter].

Terminate the connection.2

Remove the USB cable.3

The [DEVICE] USB indicator will light.

Sample Rate=44.1kHz
s:Solo

Connect the USB cable to the R16.5

Connect the USB cable 
to the computer.6

AUDIO INTERFACE icon blinks

When connection is complete the AUDIO 
INTERFACE icon appears.

Connection setting 
complete

  NOTE

Disconnecting

Data transferred with CONTINUE

 · INSERT EFFECT settings

 · SEND RETURN EFFECT settings

 · Track parameter settings

 · TUNER settings

RESET

Restores default settings for each item
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Using the control surface functions
When using the R16 connected by USB as an audio interface, the R16 keys and faders can 
be used to control Cubase LE 4’s transport and mixer.

  HINT
Assigning Keys
For a list of functions that can be assigned to 

the knobs and keys of the R16, as well as other 

transport/function keys that are supported by 

Cubase LE 4, please consult the “Control Surface 

Mode Functions Quick Reference Guide” of this 

manual.

About the control surface Control surface settings

In control surface mode the keys and knobs on 
the R16 can be assigned to particular Cubase 4 
LE functions.

7 Launch Cubase LE 4.

Transport section 	 p.10

About banks 	 p.11

Fader section	  p.11

Reference: Control Surface Functions Quick Reference Guide p.13

8 Select “Device Setup” from the 
Cubase LE 4 “Device” menu.

(The “device setup” window will open.)

9 On the top left of the device 
setup window there are [+] [-] [|<] 
buttons. Click the [+] and then 
choose “Mackie Control.”

10 Set MIDI input and output.

MIDI Input: Zoom R16

MIDI Output: Zoom R16

See R16 setup and connection 
steps 1~6 on P.7~8.
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Transport section

By setting up the control surface, the R16’s 
transport section keys can be assigned to 
individual functions in Cubase LE 4

［REW］キー ［FF］キー ［STOP］キー［PLAY］キー ［REC］キー

［F1］キー ［F5］キー［F2］キー ［F3］キー ［F4］キー

巻き戻し　 早送り 　　停止　　  再生　　  録音　

[F1 ]  Key   [F2 ]  Key   [F3 ]  Key   [F4 ]  Key   [F5 ]  Key

[REW] Key   [FF] Key   [STOP] Key   [PLAY] Key   [REC] Key 
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Fader section operation
By using the faders and status keys of the R16 fader section, you can control the volume and 
muting, pause recording and switch solo on and off in the corresponding Cubase LE 4 tracks.

Operating the fader section

1 Assign the desired Cubase 4 LE 
tracks (channels) to the fader 
section.

About banks

After setting up control surface operation, 
the main parameters of Cubase LE 4 can be 
operated using the R16’s fader and status keys.

A group of tracks operated by the faders and 
status keys is called a "bank," and one bank 
includes 8 tracks. 

For example, if fader 1 is assigned to Cubase LE 
4 track 1, tracks 1-8 can be operated as shown 
in the following diagram.

As the diagram shows, pressing the [9~16tr 
(Bank>)] key once switches the allocations as 
shown below.

Control 1 2 3 4 5 6 7 8

Track Tr.9 Tr.10 Tr.11 Tr.12 Tr.13 Tr.14 Tr.15 Tr.16

 [1-8Tr] Key (< BANK) 
   Tracks (channels) assigned to the fader section 

are moved backward by eight tracks.

 [9~16Tr] Key (BANK >) 
   Tracks (channels) assigned to the fader section 

are moved forward by eight tracks.

2 Use the faders to control the 
volumes of the corresponding 
tracks.

The faders control the volumes of their 
respective tracks. Change the master 
volume by moving the [Master] Fader.

1 / 9

Control 1 2 3 4 5 6 7 8

Track Tr.1 Tr.2 Tr.3 Tr.4 Tr.5 Tr.6 Tr.7 Tr.8
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3 Press the MASTER track status key 
to cycle through  the functions of 
the individual track status keys.

By pressing a track status key, you can 
toggle solo, mute and record enable on 
and off for the corresponding track.

R16 level meters 
(audio interface use)

Each leve l meter other 
than the MASTER displays 
the s igna l immediate ly 
before sending it to the 
computer.

The master ing leve l 
meter displays the re-
turning signal from the 
computer.

Checking DAW recording levels
By setting “REC SIGNAL” to “WET” (signal with 

effect) or “DRY” (no effect), you can send signals 

to the computer with or without being processed 

by the R16’s insert effects. 

The recording levels of the sent signals are 

displayed on the level meters. The signals shown 

on the mastering level meter and each level meter 

are different. 

Please adjust the 
l e ve l  m e te r  s o 
that i t does not 
light the red clip 
indicator.

Red light
(clipping)

Each press of the 
MASTER track key 
changes the function in 

mute>rec>solo order.

Sample Rate=48.0kHz
s:Solo
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Setting up function keys
The five keys above the transport keys can be used as function keys (F1~F5) and assigned 
as you desire.

Function key setup method

1 Open the Device Setup Dialog 
Box in Cubase 4 LE

2 Commands can be assigned in the three 
columns displayed on the right side of the 
window.

Select Mackie Control 

3 From the (Button) column 
choose the function key [F1~F5] 
to be assigned a Cubase LE 4 
function.

5

7 Press the “Apply” button.

Choose the type of Cubase LE 4 
function from the Category pop-
up menu.

6 Click on the “Command” column 
and select the desired specific 
Cubase LE 4 function from the 
pop-up menu.

(The contents of this pop-up menu will 
be different depending on the category 
chosen.)

4 Click on the “Category” column 
for that key.
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Control Surface Functions Quick Reference Sheet
These functions are for Cubase LE 4, Cubase 4, Logic Pro, SONAR, Ableton Live and Digital 
Performer.

Control Explanation

Fader section

Status Key Toggles mute, record enable or solo on the track on/off.

[MASTER] Status Key Switches the function of the status keys

Fader Controls the volume of the corresponding track

[MASTER] Fader Controls the master volume

Transport section

[Curser] Keys        Performs the same functions as the arrow keys on the computer (*1)

Dial Moves the cursor position (*2)

[REW] Key Rewind

[FF] Key Fast forward

[STOP] Key Stop

[PLAY] Key Play

[REC] Key Record

[AUTO PUNCH I/O] Key Depends on the [F1] key setting

[A-B REPEAT] Key Depends on the [F2] key setting

MARKER [|<<] Key Depends on the [F3] key setting

MARKER [>>|] Key Depends on the [F4] key setting

[MARK] Key Depends on the [F5] key setting

Control section    

[1-8Tr] Key Moves one bank backward

[9-16Tr] Key Moves one bank forward

*1: Digital Performer = Window scroll
*2: Digital Performer = No assigned function



A
u

d
io

 in
terface m

a
n

u
al

15

Recording with Cubase LE 4 
In this chapter, we explain how to record into Cubase LE 4 using the R16.

Create a new project

Copy the ZOOM R16 project 
templates to the computer.

Run Cubase LE 4.1

2 Choose “New Project” from the 
File menu.
Choose a new project template from the New 
Project Window.

Windows
C: \Program Files\Steinberg\Cubase LE 4\
templates
Macintosh
/Applications/CubaseLE4.app/Contents/
templates/
(To access the Contents folder, ctrl-click the 
Cubase LE 4 application and choose “Show 
Package Contents” from the contextual menu.)

From the CubaseLE4_template folder on the 
CD included with R16, copy the templates to the 
location where Cubase LE 4 is installed.

3 Create a new project
After copying the R16 project templates to the 
designated folder, the R16 project templates will 
be displayed when creating a new project.
By choosing these templates you will be able to 
easily create projects with audio track input and 
output settings arranged for the R16.

Template names and details

ZOOM R16 8Mono Recording

A project with Cubase LE 4 monaural tracks 1~8 
assigned to R16 [Input] 1~8

ZOOM R16 4Stereo Recording

A project with Cubase LE 4 stereo tracks 1~4 
assigned to R16 [Input] 1/2 ~ 7/8.

ZOOM R16 4Mono 2Stereo Recording

A project with Cubase LE 4 monaural tracks 1~4 
assigned to R16 [Input] 1~4 and Cubase LE 4 
stereo tracks 5~6 assigned to R16 [Input] 5/6 and 
7/8.
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  NOTE
•	 Set the recording quantization (bit depth) of 

Cubase LE 4 or the DAW software that you are 

using to 24-bit in order to achieve the best audio 

quality when recording. (See the software manual 

for how to make this setting.)

•	 The inspector displays information about the 

track currently selected. If it does not display 

anything click on a track to see that track’s 

status.

Create a new audio track

5 Set-up the created audio track 
as follows.

The project file save location window is displayed.

4 Set the save location and click 
the OK button (select button on 
Mac OS X).

This will create a new project and the Cubase LE 
4 project window will appear.

Inspector (area that allows setting of detailed 
track information) 

If the inspector is not shown, click 
here to show/hide the inspector.

Select the track input/output bus.
The names of busses of the R16 connected by 
USB will be displayed. To choose a different bus 
click here and choose a different bus from the 
menu.

To add a new audio track, select “Add Track” from 
the “Project” menu and then choose “Audio” from 
the sub-menu that appears.
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Recording With Cubase LE 4

  HINT
When the Monitor button is lit, the audio track 

input level in the level meter next to the fader will 

be displayed. When the light is off, the audio track 

output level will be displayed.

Connect an instrument

6
Connect an instrument such as 
a guitar to an R16 [INPUT] jack 
and choose an effect patch.
The chosen effect patch will be applied to the signal 
and recorded on the computer via the [USB] port.

7 Select “Mixer” from the Cubase 
LE 4 “Device” menu

The channels corresponding to the created tracks 
and the master channel will be displayed in the 
mixer window.

Reference : R16 Operation Manual

	 Selecting an input signal

	 Selecting an effect patch

How to choose the R16 input signal

8 Enable the track for recording.

Master Channel

Click the Monitor 
button until it lights 
orange.

Click the record 
enable button. It 
will light red and 
recording will be 
enabled.

Channel corresponding 
to the audio track

P.13

P.13
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  NOTE
• If the Monitor button is on, the R16 input signal 

and the signal returning to the R16 via the 

computer will both be output from the R16 at the 

same time which can create a flanger-like sound.  

If you want to monitor accurately while adjusting 

the recording level, turn the [DIRECT/DAW 

BALANCE] knob toward DIRECT.

 • For the above meter, the signal level is displayed 

after it has been internally processed by Cubase 

LE 4. Because of this, you might experience a 

slight delay between the time a string is plucked 

until the level meter moves; this is not a defect.

Set the recording level

9 While playing an instrument, 
adjust the R16 input level and set 
the Cubase LE 4 recording level.

The recording level for Cubase 4 LE can be 
checked by the level meter of the corresponding 
channel of the recording enabled track. 
Please set it as high as possible without making 
the meter peak.
When adjusting the level, do not move the Cubase 
LE 4 fader, but instead adjust the recording level 
and gain on the R16.

Level Meter

10

11

After adjusting the recording 
level, click the Monitor button to 
turn off the light.

Monitor 
button

For this operation the input level is not displayed, 
and the signal from the computer to the R16 is 
muted.

For this operation the [PHONES] and [OUTPUT] 
ports of the R16 can only be used to monitor the 
signal sent to the computer.

Confirm the Transport Panel 
display

If the Transport Panel is not displayed, select 
“Transport Panel” from the “Transport” menu.
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Recording with Cubase LE 4

Check the recording (playback)Recording

12 1Click the Record button on the 
Transport Panel

Stop button                            Record button

Recording begins.
As you play the instrument, a recorded waveform 
is drawn in real time in the project window.
To stop recording, click the Stop button in the 
transport panel.

Lower the master channel fader

2 Using the Transport Panel 
buttons, return to the beginning 
of the project.

|< Move to the beginning of the project

3 Click the Play button on the 
Transport Panel to begin 
playback.

Play button
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Tips to improve 
performance
When using Cubase LE 4, the application’s 
actions could become extremely delayed 
or  e r ror  messages  such as  “cannot 
synchronize with USB audio interface” might 
be displayed. Should such occurrences 
become frequent, taking the following 
measures might improve the situation.

➊ Terminate other running  
	 programs.

	 I n  p a r t i c u l a r,  c o n f i r m  t h a t  t h e re 
are not a large number of background 
applications running.

➋ Reduce the use of plug-ins in 
	 Cubase LE 4 (effects, sound  
	 generator plug-ins)
	 If there are a large number of plug-

ins running, the computer might be 
struggling to keep up. In addit ion, 
reducing the number of simultaneous 
playback tracks might be effective.

➌ Use the R16 AC adapter
  	 When devices draw power from the 

USB bus, on rare occasions computer 
performance can suffer. Try using the AC 
adapter.

Please increase the Audio Buffer Size in the 
Device Setup>VST Audio System menu if 
the sound breaks up.
Please refer to Installation Guide Step 5 for 
details.

Moreover, if the application performance 
is extremely slow and regular computer 
operation is affected, we recommend 
disconnecting the computer from the R16 
USB port and quitting Cubase LE 4 once 
before reconnecting the USB port and 
reopening Cubase LE 4 again.

20

  HINT
If no sound comes out after clicking the Play button 

following recording, recheck the USB connection 

settings (Step 6 above).

In addit ion, confirm that the [DIRECT/DAW 

BALANCE] control is at the center.

Check the recording (playback)

4 Raise the master channel fader 
to a suitable playback level.
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Importing audio data into Cubase LE 4
By connecting a computer and the R16 with a USB cable and setting the R16 to function as 
a card reader, you can import audio data as WAV files into Cubase LE 4 audio tracks.

Importing by drag & drop 5 Start Cubase LE 4.

6 Open the project into which you 
want to import audio data.

7 Open the R16 SD card from the 
computer and open the “Audio” 
folder of the project from which you 
want to import audio data.

Select >CARD READER3
USB
>CARD READER

Change 
menu

Push [Enter].

1 Connect the computer and the 
R16 ([DEVICE] port) with a USB 
cable.

Press [USB].2

4 Verify.

CARD READER
Enter?

Push [Enter].

Access the R16 from the computer.
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Select the file or files that you wish 
to import from the “Audio” folder 
and drag and drop them into the 
Cubase LE 4 project window.

8

When a file is dragged and dropped, a window 
asking what Cubase LE 4 should do with the file 
will open.

Select either “Different Tracks” or 
“One Track” as the import method.9
G e n e r a l l y,  s e l e c t  “ D i f f e re n t  Tr a c k s ”  t o 
automatically create one track for each file. The 
files will be arranged vertically in the project 
window.  
Selecting “One track” will create one track with 
the audio files arranged horizontally. If you drag 
audio files on top of existing tracks, they will be 
placed into those tracks

This window appears where you can select the 
import method.

In the “Import Options” window 
click the “Copy Files to Working 
Directory” check box, and click the 
OK button. 

10

The audio files are loaded into 
Cubase LE 4.

  HINT
 · The USB cable can be connected even when the 

computer or the R16 is on.

 · If the R16 is connected when off, it can be run on USB 

bus power.

 · Project data is stored in the SD card root directory 

in folders named “PROJxxx” (xxx=project 

number). Audio data is stored as WAV files in the 

“AUDIO” subfolders of each “PROJxxx” folder.

 · Master tracks and stereo tracks are stereo WAV files.

 · To copy a WAV file from the computer to an R16 

project, copy it to the “AUDIO” subfolder of the 

desired “PROJxxx” project folder (xxx=project 

number). Then assign the files to tracks using the 

functions of the R16.



A
u

d
io

 in
terface m

a
n

u
al

23

Importing audio data into Cubase LE 4

Using the “Import” command

Select >CARD READER3
USB
>CARD READER

Change 
menu

Push [Enter].

1 Connect the computer and the 
R16 ([DEVICE] port) with a USB 
cable.

Press [USB].2

4 Verify.

CARD READER
Enter?

Push [Enter].

Access the R16 from the computer.

5 Start Cubase LE 4.

From the Cubase LE 4 “File” 
menu select “Import” and “Audio 
File…”

The “Import Audio” window appears.

7

6 Open the project into which you 
want to import audio data.
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Select the desired audio file or 
files from the “AUDIO” folder of 
the project from which you wish 
to import.  Click “Open.”

Importing files will cause the “Import Options” 
window to appear.

8

9 In the “Import Options” window 
click the “Copy File to Working 
Directory” check box, and click 
the OK button. 

When a file is imported, a window opens asking what 
Cubase LE 4 should do with the files.

Select either “Different Tracks” or 
“One Track” as the import method.10

G e n e r a l l y,  s e l e c t  “ D i f f e re n t  Tr a c k s ”  t o 
automatically create one track for each file. The 
files will be arranged vertically in the project 
window.  
Selecting “One track” will create one track with 
the audio files arranged horizontally. If you drag 
audio files on top of existing tracks, they will be 
placed into those tracks

  HINT
 · The USB cable can be connected even when the 

computer or the R16 is on.

 · If the R16 is connected when off, it can be run on USB 

bus power.

 · Project data is stored in the SD card root directory 

in folders named “PROJxxx” (xxx=project 

number). Audio data is stored as WAV files in the 

“AUDIO” subfolders of each “PROJxxx” folder.

 · Master tracks and stereo tracks are stereo WAV files.

 · To copy a WAV file from the computer to an R16 

project, copy it to the “AUDIO” subfolder of the 

desired “PROJxxx” project folder (xxx=project 

number). Then assign the files to tracks using the 

functions of the R16.
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The mixer in audio interface mode
In audio interface mode you can make a mix for monitoring using the R16’s internal mixer. In 
addition, you can adjust the balance of the internal mixer and the sound from the computer.

  NOTE
The R16 REVERB SEND, PAN, VOLUME and 

STEREO LINK settings are all saved when you 

terminate audio interface mode and can be used 

again the next time by choosing [CONTINUE] when 

you relaunch audio interface mode.

You can be adjust the REVERB SEND, PAN, 
VOLUME and STEREO LINK settings as in 
recorder mode.
Operation is the same as in recorder mode.
(Reference: OPERATION MANUAL P.37)

The PAN/EQ Menu

Input1
VOLUME=0

VOLUME

You can set the volume levels for INPUT 1~8 between 
0~127 (increments of 1). 100 is the default.

This is the first menu item displayed when you push the 
[PAN/EQ] key in audio interface mode. 

Input1
REVERB SEND=0

SEND REVERB

You can change the reverb send levels for INPUT 1~8 
from 0~100 (increments of 1) with 0 as the default (same 
as in recorder mode).

Reverb only affects the monitored signal.

Input1
   |-----+---|-|

PAN (BALANCE)

You can change the pan for INPUT 1~8 between 
L100~R100 (increments of 2) with C (center) as the 
default (same as in recorder mode). 

Input1
STEREO LINK On

Link even and odd numbered INPUTS to handle them as 
a stereo pair.

On/Off with “Off’ as the default.
By setting up a stereo link, REVERB SEND, PAN and 
VOLUME track parameters can be applied to even and 
odd inputs simultaneously. The odd numbered fader will 
be active (same as in recorder mode).
（Reference : OPERATION MANUAL P.20）

Volume, reverb send and pan

[BALANCE]

In audio interface mode the balance of the 
signals monitored from the inputs and the signals 
returning from the computer can be adjusted 
with the [BALANCE] knob.

Left

Only the signals 
from INPUT 1~8

Right

Only the DAW 
stereo signal

STEREO LINK
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Tuner
The R16’s tuner can be used in the same way as in recorder mode. For further details 
please consult the OPERATION MANUAL.

1 Press [TOOL].

Select >TUNER2
TOOL
>TUNER

Change 
menu

Push [Enter].

CHROMATIC TUNER
TOOL>TUNER>CHROMATIC

4 CHROMATIC      440Hz

Select the base pitch 
and tune the instrument.

CHROMATIC      440Hz
>>A

Displays the note closest to the 
input signal.

Displays whether the pitch is higher or 
lower than the displayed note.

Change the base pitch

3 Select tuner type.

Change 
tuner type

Change 
tuner type

GUITAR          440Hz
<E>           String6

            Chord / Note

Tuner Type

CHROMATIC      440Hz

Base Pitch

  NOTE
Tuner settings are saved when you terminate audio 

interface mode and can be used again the next 

time by choosing [CONTINUE] when you relaunch 

audio interface mode.

  HINT
 · The default base pitch is 440 Hz.

 · Tuners other than the chromatic tuner can be used.

   (Reference : OPERATION MANUAL P.31)
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Effects in audio interface mode
The R16’s insert and send return effects can both be used when the sampling wavelength is  
set to 44.1 kHz. Basic operation is the same but there are a few differences in the menus.

  NOTE
 · Effects can only be used when the sampling rate 

is 44.1 kHz.  At all other times it is turned OFF.

 · Insert and send return effect settings are saved 

when you terminate audio interface mode and 

can be used again the next time by choosing 

[CONTINUE] when you relaunch audio interface 

mode.

Insert effect Send return effect (reverb)

As in recorder mode, select the insert location 
and the insert effect algorithm, as well as the 
effect patches to be applied to the recording 
signal.  

Insert effect menu

No.00:Standard
>INPUT SOURCE

Select the insert location

You can set it for any INPUT from 1~8.

(Reference : OPERATION MANUAL P.49)

No.00:Standard
>REC SIGNAL

Apply the effect only to monitoring

If you set “REC SIGNAL” to “Dry,” the effect will only be 
applied to the monitoring signal and will not affect signals 
recorded in DAW software. 

(Reference : OPERATION MANUAL P.55)

When in audio interface mode reverb can only 
be used for monitoring. As in recorder mode, 
you can use the [SEND RETURN EFFECT] menu 
to change the patch and the [PAN/EQ] menu to 
set the send level that adjusts the depth of the 
reverb signal.

Send return effect menu

SEND REVERB
No.00:TightHal

REVERB SEND

By altering the send level of the REVERB you can adjust 
the depth of the added signal.

In audio interface mode the [SEND RETURN 
EFFECT] key opens the “SEND REVERB” menu, 
which is different from the recorder mode.
(Reference: Printed Manual P.35~45)
(Reference: Audio Interface Manual P.25)
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Working with patches
After you have made many edits, you might want to restore pre-edited settings by initializing the 
patch. This will return it to its factory preset condition.

  HINT
Even if you have not imported patches the initial 

settings of patches that were used in the recorder 

mode can be used.

1 Pressor
Turn EFFECT On if Off

press [ENTER].
If “EFFECT Off” is displayed,

Patch initialization (factory reset)
EFFECT> select patch> PATCH INITIAL

Change 
menu

3 Press [  ].

No.00:Standard    
>EDIT

CLEAN           <IN1>
No.00:Standard	

2 Select algorithm/patch.

Change 
menu

PATCH
Initial?

5 Confirm.

Press [ENTER].

Select >PATCH INITIAL.4

Press [ENTER].

No.00:Standard    
>PATCH INITIAL

No.00:REVERB    
>PATCH INITIAL

Change 
menuSend return effect (only reverb) example

Insert effect example

Select an insert effect or send return 
effect patch

Press either INSERT EFFECT or SEND RETURN 
EFFECT and select a patch from an algorithm.
(Reference: OPERATION MANUAL P.48)

Patch editing and renaming (EDIT)
By adjusting the effect module parameters you can set 
it to create the desired result. You can also change the 
name.
(Reference: OPERATION MANUAL P.53)

Importing patches (IMPORT)
All algorithms (as well as reverb patches) from the effects 
of the project selected on the R16 can be imported and 
saved as a single patch.
(Reference: OPERATION MANUAL P.54)
*In the audio interface mode, one complete set of effect 
data is saved for the mode. There are no project based 
settings.

Saving patches (SAVE)
Adjusted patches can be saved.
(Reference: OPERATION MANUAL P. 53)

Initializing patches (INITIAL)
Restores patches to their original factory settings (only 
available in audio interface mode).

Patch operation menus

Patch operations
For both insert and send return effects 
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Control surface setup for other DAWs
You can set and use the R16 as a controller in a variety of DAW software besides Cubase 
LE 4. Please refer to the manual for the software that you are using.

       Logic 7/8

Control surface setup Function key setup

Select “Preferences” > 
“Control surface” > “Setup”  
from the “Logic Pro” menu.

This opens the “Setup” window.

Click on the top left “New” and 
select “Install” from the pull-
down menu.

Select “Mackie Designs/Mackie 
Control/Logic Control” from the 
list in the “Install” window and 
click the “Add” button.

"Mackie Control" will be added to the setup 
window.

Select the “Mackie Control” 
icon. Then, from the top of the 
list at the left set “Out Port” and 
“Input” to “ZOOM R16” using 
their pull-down menus.

Select  “Preferences” > 
“Control surface” > “Controller 
Assignments…” from the “Logic 
Pro” menu.

This opens the “Controller Assignments” window.

From the “Zone” column select 
“Control Surface: Mackie Control.” 

Change the functions as you like. 
Controls F1~F5 correspond to 
the F1~F5 keys on the R16.

The above procedures are for Logic Pro 8.

The names of the menus might be different in a 
different version of Logic.

Please refer to the manual for the version of Logic 
that you are using for details.

1 1

3 3

4

2 2
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       SONAR 7/8

Control surface setup Function key setup

Choose option-controller/
surface menu to open the 
controller/surface dialog.

If a controller/surface has already been selected, 
click on the "Delete" button and delete the 
controller/surface.

Click the “Add” button and open 
the “Controller/Surface Setup” 
dialog.

Choose “ZOOM R16” from 
the drop-down menu of the 
“Controller/surface” column.

Select “ZOOM R16” in the input/
output port column.

For Cakewalk SONAR, installation of a control 
surface plug-in is necessary. Please install it when 
installing the driver.

Choose “Option key bind” to 
open the “Key bind” dialog.

Press “Search for the key” in 
“Setup.”

Select a function that you want 
to assign an F1-F5 key to and 
then press that key on the R16.

The above procedures are for Sonar 7.

The names of the menus might be different in a 
different version of Sonar.

Please refer to the manual for the version of Sonar 
that you are using for details. 

1 1

3

32
2

  HINT
The F1~F5 keys on the R16 are labeled as follows. 

F1: [AUTO PUNCH IN/OUT] key

F2: [A-B REPEAT] key

F3: MARKER [|<<] key

F4: MARKER [>>|] key

F5: [MARK/CLEAR] key
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Control surface setup for other DAWs

        LIVE 6/7

After starting Live 7, select 
“Preferences” from the “Option” 
(Windows) or “Live” (Mac) menu. 

The Preferences window will open.

Click “MIDI” on the left side of 
Preferences window. 

The setup window related to MIDI will open.

Select “Mackie Control” in the 
pull-down menu of the Control 
Surface column.

Select “ZOOM R16” from the 
pull-down menus of the Input 
and Output column.

In the MIDI Ports section below, 
turn “On” the Remote column 
button for the “Input: Mackie 
Control Input (Zoom R16)” item.

Press the MIDI button at the top 
right of the main LIVE window to 
open MIDI map mode. 

Interface elements that can be 
assigned will be highlighted in 
blue. Click on the parameter that 
you want to assign an F1~F5 key 
to control.

Press the F1~F5 key of the R16 
that you want to use to control 
the selected parameter in Live.

The above procedures are for Live 7.

The names of the menus might be different in a 
different version of Live.

Please refer to the manual for the version of Live 
that you are using for details.

1 1

3 3

4

5

2
2

Control surface setup Function key setup

  HINT
The F1~F5 keys on the R16 are labeled as follows. 

F1: [AUTO PUNCH IN/OUT] key

F2: [A-B REPEAT] key

F3: MARKER [|<<] key

F4: MARKER [>>>|] key

F5: [MARK/CLEAR] key
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        Digital Performer 5/6

Launch the Audio MIDI Setup 
application. (/Applications/
Utilities).

Click the MIDI Devices tab and 
confirm that “ZOOM R16” is 
displayed.

Click “Add Device.”  
A “new external device” will be added.

Double-click the “new external 
device” to open its “Information” 
window.

Enter the name “R16” in the 
“Device Name” field.

Click and drag the downward 
arrow of the original “ZOOM 
R16” icon and connect it to the 
downward arrow of the “R16” 
icon that you added. 
Use same method to connect the upward arrows.

Start Digital Performer.

Select “Control Surface Setup” 
from the “Setup” menu.
The Control Surface window will open.

Click the “+” icon in the Control 
Surface window and select 
“Mackie Control” from the 
“Driver” pull-down menu.

1

9

10

11

12
3
4

5
6

7
8

2

Select “Mackie Control” from the 
“Unit” pull-down menu that will 
be displayed at bottom.

Select “R16” from the “MIDI” 
pull-down menu of the Control 
Surface window and select [R16-
1] from the menu list.

Click the “OK” button.

The above procedures are for Digital Performer 5.

The names of the menus might be different in a 
different version of Digital Performer.

Please refer to the manual for the version of Digital 
Performer that you are using for details.

Control surface setup 

The default functions are allocated in Digital Performer 
and you cannot change these functions.

F1 [AUTO PUNCH IN/OUT]:	 Selects YES in 

			   dialog boxes

F2 [A-B REPEAT]: 	 Selects NO in dialog boxes

F3 MARKER [|<<]: 	 Creates track groups/groups

F4 MARKER [>>|]: 	 Releases pause and stop of 

		  track group/group function

F5 [MARK/CLEAR]: 	 Releases track group/group 

		  function

Refer to sections about Mackie Control dialog boxes and 
track groups in the Digital Performer manual.

Function key setup

 Samplitude

 · Mackie Control is a registered trademark of LOUD 
Technologies Co.

 · Other trademarks and registered trademarks 
in this document belong to their owners.
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“PDF Manuals and Drivers” CD-ROM supplied with R16
Drivers>Windows “Setup.exe”
or
Download the latest “ZOOM R16 Audio Driver” from 
ZOOM homepage (http://zoom.co.jp)
and install it on a computer.

ZOOM R16 Audio Driver software is required to enable use of 
Cubase LE 4 for audio input and output with a computer. Refer 
to the read_me file included in the download package for 
instructions on how to install the driver correctly.

[How to install the driver]

Double-click Setup.exe file to activate the installer.

   Set language selection 

Continued overleaf

Cubase LE 4 Startup Guide

This Cubase LE 4 Startup Guide explains how to install Cubase LE 4 on a computer, make connections and other settings for the R16.Windows Vista / XP

To connect the R16 to a computer running Windows Vista 
(or Windows XP) and to enable audio input/output, proceed 
as follows. The installation description uses Windows Vista 
as an example.

Insert the supplied “Cubase LE 4” DVD-ROM into 
the DVD drive of the computer.

When you insert the DVD-ROM, a screen asking what you want 
to do appears. Select “Open folder to view files”.
When the contents of the DVD-ROM are shown, open the 
Cubase LE 4 for Windows folder by double-clicking on it, and 
then double-click the executable “Setup” (“Setup.exe”) file to start 
the installation process.

Bring up the “Sound” window from the Control Panel 
and make the input device setting for the computer.

To bring up the “Sound” window, select “Control Panel” from the 
Start menu and click “Hardware and Sound”, then click “Sound”.

In the “Sound” window, verify that “R16 Audio Interface” is listed 
under the Play and Record devices and that the device is 
checked. (To switch between Play and Record, click the tabs at 
the top of the window.)
If the device is not checked, right-click on the icon for the device 
and click “Set as Default Device” so that a check mark appears.

When the connection is operated on the R16, it is recognized by 
the computer.
If this is the first time to connect the R16, wait until the message 
“Your devices are ready to use” appears.

   Start to “Found New Hardware Wizard”

   “Found New Hardware Wizard completed”
Click [Finish] to complete installation.

When connected operation on the R16 side is finished, it is 
recognized by the computer. 
Connects the first time,Please wait until the message of "The 
device was able to be prepared" is displayed. 

Click [Next] to start 
installation.

If you use SONER, 
select  Instal lat ion 
Plug In for Control 
Surface.

Click [Install] to start 
installation.

Click [Complete] to 
finish installation.

Choose [No, not this 
t i m e ] o f  W i n d o w s  
Update and click[Next].

Choose  [ Ins ta l l  the  
software automatically] 
and click [Next]to start 
installation.

  HINT
If nothing happens when you insert the DVD-ROM, open the Start 

menu and select “Computer” (“My Computer” in Windows XP). Then 

double-click the “Cubase LE 4” DVD-ROM icon to display the contents 

of the DVD-ROM.

  NOTE
To use Cubase LE 4 continuously, it is necessary to have the User 

Registration and the Software License Authentication. The Registration 

and Authentication are available to be processed when Cubase LE 4 is 

activated on a computer connected to the internet. Click “Register now” 

which is shown when activating, enter all the items. If it is not recognized 

as Registration, Cubase LE 4 can only be used for a limited period after 

installation.

  NOTE
We recommend you upgrade the system software to the latest version on 

the R16. An R16 operated on an old system may not be recognized 

correctly. The latest version can also be downloaded from our homepage.

  NOTE
Use a high-quality USB cable and keep the connection as short as 

possible. If USB bus power is supplied to the R16 via a USB cable 

which is more than 3 meters in length, the low voltage warning 

indication may appear.

Choose language and 
click [OK].

Set and connect the R16 to the computer 
using a USB cable.

Connect USB cable to the R16

Connect USB cable 
to computer

USB 1/3
>AUDIO INTERFACE

Menu moves

Select >AUDIO INTERFACE

Press.

AUDIO INTERFACE
Enter?

Execute.

Press.

Sample Rate=48.0Hz
s:Solo

SETTING
[CONTINUE] RESET

Menu moves

Select of how to continue settings.

Press.

1
2

3

4

5

6

Press.

USB indicator [DEVICE] flashes

AUDIO INTERFACE flashes

Rate=48.0Hz

Rate=48.0Hz

INTERFACE flashes when the connection is complete Connection setting completed

How to set and connect the R16

   Start InstallShield Wizard 

   Driver-Plug In selection screen 

   Ready to install the program 

If a warning dialogue “Install software” appears, click [Continue].
If a warning dialogue “Windows security Driver Software Licensee 
cannot be verified.” appears, click [Install this driver software].

*A message “ZOOM R16 Audio Driver (No Response)” may appear, 
 but it is not a problem. Wait until it responds.

   InstallShield Wizard was completed 

DAW software
Cubase LE 4 etc

Windows PC

USB cable

[PHONES]Jack
Audio system, 
headphones or other 
playback equipment

[OUTPUT]Jack
Audio components, 
amp built-in 
speakers etc

[INPUT 1-8]Jack
Guitar, other instrument or 
built-in stereo mic

R16

ZOOM R16 Audio Driver

If a warning dialogue “Install hardware” appears, click [Continue].



Rate=48.0Hz

When the connection is operated on the R16, it is recognized by 
the computer.

Open the “Applications” folder and then the 
“Utilities” folder, and double-click “Audio MIDI 
Setup”.

The Audio MIDI Setup screen appears. Click “Audio Devices” 
and check that “ZOOM R16 Driver” is selected as default 
input/default output.

If another device is selected, use the pull-down menu to 
change the selection to “ZOOM R16 Driver”.
When the setting is done, close Audio MIDI Setup.

Start Cubase LE 4. Then access the “Devices” 
menu, select “Device Setup...” and click “VST 
Audio System”.

To start Cubase LE 4, double-click the Cubase LE 4 icon in the 
“Applications” folder.
After startup, be sure to verify that “ZOOM R16 Driver” is 
selected in the right section of the Device Setup window.

Start Cubase LE 4. Then access the “Devices” 
menu, select “Device Setup...” and click “VST 
Audio System”

To start Cubase LE 4, double-click the Cubase LE 4 shortcut 
icon which was created on the desktop. 
After startup, select “ZOOM R16 ASIO Driver” as the ASIO 
driver in the right section of the Device Setup window. When 
you change the ASIO driver selection, a confirmation message 
appears. Click the “Switch” button.

The device indication in the left section of the window now 
shows “ZOOM R16 ASIO Driver” as the ASIO driver.
Click on this indication to select it, and then click the “Control 
Panel” button in the right section of the Device Setup window.

The window which appears lets you set the buffer size for the 
ASIO driver. The buffer size should be set to a value which is 
as low as possible without causing sound dropouts during 
recording and playback. 
The sampling frequency can be changed in Cubase LE 4 in 
Project Settings.

When the setting is complete, click the OK buttons in the 
respective windows to return to the startup condition of 
Cubase LE 4.

From the “Devices” menu of Cubase LE 4, select 
“VST Connections” and set INPUT(Input channel 
1 - Input channel 8) as the input port to be used 
and Output channel 1, Output channel 2 as 
Output port on the displayed window.

Use the tabs at top left to switch between input and output, and 
verify that “Input channel 1 - Input channel 8 / Output channel 1, 
Output channel 2” are selected as device ports. 
If another device is selected, click the device port field and change 
the selection.

Insert the supplied “Cubase LE 4” DVD-ROM into 
the DVD drive of Macintosh. And start installation.

The contents of the DVD-ROM will be shown automatically. If 
they are not shown automatically, double-click “Cubase LE 4” 
icon displayed on the desktop.
When the contents of the DVD-ROM 
are shown, double-click “Cubase LE 4 
for Macintosh X” icon to open and 
install it using “Cubase LE 4.mpkg”.

Continued from front Windows Vista / XP This Cubase LE 4 Startup Guide explains how to install Cubase LE 4 on a computer, make connections and other settings for the R16.Mac OS X

  NOTE
Use a high-quality USB cable and keep the connection as short as 

possible. If USB bus power is supplied to the R16 via a USB cable 

which is more than 3 meters in length, the low voltage warning 

indication may appear.

To connect the R16 to a computer running Mac OS X and 
to enable audio input/output or control R16 as control 
surface for Cubase LE 4, proceed as follows.

Set and connect the R16 to Macintosh 
using a USB cable.

Connect USB cable to the R16

USB 1/3
>AUDIO INTERFACE

Menu moves

Select >AUDIO INTERFACE

Press.

AUDIO INTERFACE
Enter?

Execute.

Press.

Sample Rate=48.0Hz
s:Solo

SETTING
[CONTINUE] RESET

Menu moves

Select of how to continue settings.

Press.

1
2

3

4

5

6

Press.

How to set and connect the R16

Connect USB cable 
to computer

USB indicator [DEVICE] flashes

Rate=48.0Hz
INTERFACE flashes when the connection is complete

Connection setting completed

 AUDIO INTERFACE 
flashes

For optimum enjoyment

While using Cubase LE 4, other applications may slow down 
drastically or a message such as “Cannot synchronize with USB 
audio interface” may appear. If this happens frequently, consider 
taking the following steps to optimize the operation conditions for 
Cubase LE 4.

1) Shut down other applications besides Cubase LE 4.
In particular, check for resident software and other utilities.

2) Reduce plug-ins (effects, instruments) used 
 by Cubase LE 4.
When there is a high number of plug-ins, the computer's processing 
power may not be able to keep up. Reducing the number of tracks 
for simultaneous playback can also be helpful.

3) Power the R16 from an AC adapter.
When a device designed to use USB power is powered via the USB 
port, the current supply may sometimes fluctuate, leading to 
problems. See if using an AC adapter improves operation.

Please set latency from the device menu when the sound 
cutting occurs.  Refer:  Install Guide-step5 about details.

If applications still run very slowly or the computer itself does 
not function properly, disconnect the R16 from the computer 
and shut down Cubase LE 4. Then reconnect the USB cable 
and start Cubase LE 4 again.

DAW software
Cubase LE 4 etc

USB cable

R16

[PHONES]Jack
Audio system, 
headphones or other 
playback equipment

[OUTPUT]Jack
Audio components, 
amp built-in 
speakers etc

[INPUT 1-8]Jack
Guitar, other instrument 
or built-in stereo mic

ZOOM R16 Driver

Macintosh

If another device is selected, use the pull-down menu to change 
the selection to “ZOOM R16 Driver”.
When the setting is done, click OK button and close the window.

From the “Devices” menu of Cubase LE 4, select 
“VST Connections” and select the device containing 
the string “ZOOM R16 Driver 1 ~ 8” as input port 
and output port.

Use the tabs at top center to switch between input and output, 
and verify that “ZOOM R16 Driver 1 ~ 8” is selected as device 
port.
If another device is selected, click the device port field and 
change the selection.

“PDF Manuals and Drivers” CD-ROM supplied with R16
Drivers/Mac “ZOOM R16Driver”
or
Download the latest “ZOOM R16Driver” from 
ZOOM homepage (http://zoom.co.jp)
and install it on a computer.

ZOOM R16Driver software is required to enable use of 
Cubase LE 4 for audio input and output with a computer.
Double-click installer (ZOOM R16 
Driver.pkg) icon. Start instal l  i t  
according to the instruction. 

ASIO Driver

This button is clicked.Clicking here …


